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Thank you for purchasing Layad Circuits’ KITOO8 or the Basic 2WD Robot Kit. This kit is designed as
an introductory kit for microcontroller-based maobile robots. Aside from the kit specifications, this
user guide will cover instructional information on how the robot is assembled and shall also provide
exercises that demonstrates the capabilities of the kit. This document is prepared to cater to
beginners as a step by step guide in building and programming a working mobile robot. It may also
serve as reference for advanced users. Mechanical assembly, electronics and some degree of C
programming are the ideal prerequisites in performing these exercises.

KIT CONTENTS

ARDUINO/SALENG UNO

At the heart of the kit is a microcontroller board from one of the possible options below. All these
boards are based on the ATmega328 microcontroller chip and all work with the software tool called
Arduino IDE.

Option A: Arduino Uno DIP version Option B: Saleng Uno Option C: Arduino Uho SMD version

USB CABLE

A type-A-to-type-B USB cable is provided mainly
as a means to program the Arduino/Saleng
board from a computer. It may also be used to
interface a computer to the microcontroller.
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MOTOR DRIVER MODULE

Your kit will come with either the L298N or
the L293D [Kimat L293D by Layad Circuits)
motor driver modules. The motor driver
module is a modular circuit used to control
the DC motors using the Arduino’s General
Purpose 1/0 [GPIO) pins. There are two
such circuits, called a full H-bridge circuit,
built into the module. This module in
combination with the Arduino allows
direction and speed control of the DC
motors.

18650 LITHIUM-ION BATTERIES

The kit includes two 18650 Lithium lon (li-lon) batteries
rated at least 800mAh. These batteries may come in a
variety of colors and either button or flat top. The
batteries have a nominal voltage rating of 3.7V and
maximum full charge voltage of 4.2V.
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e Do not short circuit
e Dispose of properly
e Do not incinerate

¢ Do not disassemble

(U

BATTERY HOLDER

The battery holder accepts two Li lon batteries
and connects them in series forming a total
maximum voltage of 8.4V at its DC plug.
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ULTRASONIC SENSOR

The Arduino may use the ultrasonic sensor
module to determine distance following sonar
time of flight technique. That is, to emit ultrasonic
waves and determine the time they bounce back
into the sensor. Distance is then determined in
the program by simple math given the time and
known speed of sound in air. This sensor will be
used in this kit for detecting obstacles.

DC JACK BREAKOUT

The kit will contain either a Kimat DC Jack
Breakout board or a an equivalent adapter and
shall perform the following functions:

e Accepts power from the battery’s DC
plug

¢ Allows connection of the power to the
motor driver with its terminal block

Kimat DC Jack
breakout adapter

CONNECTORS

A set of connectors for 0.1” pin headers are
provided for easier connection of signal lines.
Cut-of f the female headers of 2 wires as this will
be needed for the power connection of the
Arduino.
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POWER WIRE

A two-wire cable is also included to connect the

battery to the motor driver via the terminal of the ~

DC jack breakout. This is thicker than the
connectors since it is expected to carry higher

current.
CABLE TIES
The cable ties are used to secure the ultrasonic
sensor and other components to the acrylic base
of the robot chassis.
DOUBLE SIDED TAPE

The double sided foam tape is used to secure
the following into the acrylic base:

¢ Arduino/Saleng Uno
¢ Motor Driver

e Battery holder

e DC Jack breakout

DC MOTORS

Two DC motors are included. The motors have built-in gear boxes
for added torque. The motor shafts are fitted with plastic coupling
for ready interface into the wheels. If you need wires soldered
into the motor terminals, contact us at info@layadcircuits.com or
facebook.com/layadcircuits for the customization of your kit.
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WHEELS

The plastic wheels are made of light-weight
material and are ready to fit into the DC motor
shafts. Care should be taken when inserting the
wheel into the shaft

ACRYLIC BASE BOARD

The base board holds everything in place.
Underneath the board, the motors and wheels
are attached using the provided acrylic clips and
screws. The rest are installed on top.

The base board is made with multiple holes for
maximum options in the installation of the
different boards and components.

BASE BOARD ATTACHMENTS

The kit also comes with different screws,

TTTT1 standoff and acrylic clips for the attachment for
the wheels and motors into the base board

& Em 0000
B Em 00040

THIRD WHEEL

A smaller caster wheel is also provided as a support
for the body. This is not driven by the motors but
merely as a support to maintain the base board
horizontal
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ARDUIND OVERVIEW

The Arduino/Saleng Uno board contains a microcontroller unit [MCU), the ATMega328P, installed
within the printed circuit board.

The board contains the ATmega328P and the essential circuits such as:

e Regulator circuit = converts the higher voltage input from the DC jack to 5V which is used by
the rest of the circuit. In the Saleng Uno, a 3.3V requlator circuit is also integrated allowing for
3.3V operation.

e Oscillator circuit = this is the main clock source of the MCU and is normally running at 1I6MHz.

e USB-to-Serial converter - this circuit allows the board to communicate directly with a
computer via the USB. This is used for the programming of the board and for exchanging
Serial data between MCU and computer.

e LED’s - there maybe several LEDs in the board but there are 2 important LEDs:

o The power LED - labeled as “PWR” in the Saleng Uno and may be unlabeled in the
Ardino Uno board. This lights up when power is available. This is hardwired to the output
of the regulator circuit.

o The “L” LED - labaled as “L” in the Arduino or Saleng Uno board is controlled by digital
pin 13 [DI3) and hence may be controlled by the software.

The MCU is an Integrated Circuit that contains 3 major elements:

A processor - this performs the mathematical, logical operations that is central to a computer
2. Memories — the ATMega328P integrates 3 memory types:

2.1 Flash = this 32Kb memory holds the software [“program” or “code” or “sketch” in Arduino
parlance) or the set of instructions that the user wants the MCU to perform. This is normally
writable only during programming of the MCU (“uploading”).

2.2 RAM - specifically, a 2Kb SRAM is the MCU’s “scratch pad” or working memory used
during run time. Among those that get allocated into the RAM are global variables declared in
the software, these, the user may access this memory any time during run time.

2.3 EEPROM - this is a IKB memory for storing data that are not part of the instructions but

may be accessed and edited during runtime. This is good for storing settings, serial numbers,
and similar. In this document, we will not be using the EEPROM.

In terms of data volatility, the memories are either volatile or non-volatile:
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Volatile Memory Non-Volatile Memory
Data maintained only Data is retained even when
when power is available. power is not available.

Data is erased upon power
cycle
Example: RAM Example: Flash and EEPROM

GPIO pins 0-13

L LED
POWER LED

DCJACK =2
GPIO pins AD-A5

L LED GPIO pins 0-13
POWER LED
USB PORT =

DCJACK >

GPIO pins A0-A5

3. General Purpose Input/Qutput [GPIO) = are the “pins” or I/0 of the MCU that are assigned by
the software to function as either an input or output pin. They may also be classified
according to the circuit behind the pin and the user defined function:
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Digital Input Accepts digital logic or HIGH (logic 1 7 5V)
and LOW (logic O 7 OV). All of the 20 GPIO

pins may be used as digital outputs.

Digital Output = Qutputs either HIGH or LOW. All of the 20
GPIO pins may be used as digital outputs.

Analog Input Accepts a varying signal between 0OV and
5V and represents the actual votlage as a
number between O and 1023 in the
program. Only pins AO — A5 may be used
as analog input pins.

PROGRAMMING

The basic development setup is composed of 3 elements:

Avoid using pins 0 and | as these are
e The Arduino/Saleng Uno = with or without the shared with the programming port. If
application circuit. it cannot be avoided, disconnect
e USB cable whatever circuit is connected during
e Computer = where the Arduino IDE programming. Replace after
software is running. In this document, we programming.
will only consider Windows operating system

The program (code) is developed in the computer and then transfer to the Arduino/Saleng Uno during
the “upload” process. In this document, we shall refer to the program/sketch simply as code.

The code is written in a slightly modified version of C and C++ programming language. The user is
expected to have some knowledge of this as it is beyond the scope of this document. Important
programming topics may be discussed to present certain concepts. Check with Layad Circuits if you
are in need of other kits covering programming. User who may not be interested in learning C/C++
may simply copy the codes provided and perform the upload.
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PREPARING YOUR COMPUTER

Before any programming can be done, there are a few things to prepare in the computer.

l. Kits with the Arduino Uno SMD version or Saleng Uno will need to install the USB driver
separately. Kits with the Arduino Uno DIP version may skip this step as the USB drivers are
installed in the succeeding steps.

a. Download the driver from the link below:
http:/ /layadcircuits.com/ds/SalengUno/drivers/CH34ISER.ZIP

b. Extract the contents of the zip file. Run SETUP.EXE
CH341SER v

Name

~ DRVSETUP64

CH341PT.DLL

) &8 DriverSetup(X64) —
CH341564.5YS

2 Device Driver Install / Unlnstall
CH341598.5YS

Select INF ‘BH3II1SEFI.IHF

> WCH.CN
[ bl } |__ USB-SERIAL CH3!

|__ 81/30/2819

=4 CH341SER.CAT

] CH341SERINF

CH341SER.SYS UNINSTALL

CH341SERVXD
HELP

#2 SETUP.EXE |

c. Install the driver. You should see the following upon successful installation. Incase you
have already installed the driver previously, installation may fail, in this case, uninstall
first if you want to re-install

www layadcircuits.com Copyright 2022 © Layad Circuits All Rights Reserved revl.0.0 22/02/28 9
Layad Circuits Electronics Engineering Supplies & Services, B314 Lopez Bldg., Session Rd. cor. Assumption Rd., Baguio City, Philippines
General inquiries: info@layadcircuits.com Sales: sales@layadcircuits.com FB: faceboolc.com/layadcircuits Mobile: +639164428565




O AYADGEIRGEUIHS USER GUIDE
KITOO8: Basic 2WD Robot Kit

@) WANATEGEIDIGITARSIENGINEERING

DriverSetup

o The drive is successfully Pre-installed in advance!

d. Restart your computer

2. Download and Install the Arduino IDE software
a. Download the installer from the link below
https.//www.arduino.cc/en/software

« 3> & J arduino.cc/en/saftware I

% HARDWARE SDFTWARE CLaUuD DOCUMENTATION w COMMUNITY w BLOG ABDUT

Downloads

DOWNLOAD OPTIONS

ArdUinO |DE 1 .8.1 9 Windows Win 7 and newer

Windows ZIP file

Windows app Wing1eor10 | Ge

The open-source Arduino Software (IDE) makes it easy to write code
snrd tinlnsd it ta tha hnsed Thic cafharmra can ha oeard with anu

P3 3> DU h-Yido] P20 Other

3 JUST DOWNLOAD CONTRIBUTE & DOWNLOAD

b. Double click on the installer after downloading. Follow onscreen instructions.
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ACTIVITY I: FIRST UPLOAD

l. Connect the Arduino/Saleng Uno into the computer using the USB cable. The computer should
indicate with a notification tone that the hardware has been recognized.

2. Launch the Arduino IDE installed in the computer
File Edit Sketch Tools Help

sketch_mar16a §

void setup{) {

// put your setup code here, to run once:
pinMode {13, QUTPUT} ;
}

void loop{} {

// put your main code here, to run repeatedly:

[ T = TR R SN O BT - S % RN o B =

digitalWrite (13,
}
3. Go to tools>ports and check the list of COM port(s). Your computer should assign a COM port

number to your Arduino if it is detected properly. In the picture below, the COM number is
COM4 and may not be the same for other computers.
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File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_mar1¢ Fix Encoding & Reload

1 void setup Manage Libraries... Ctrl+Shift+]

- // Ut ¥ Serjal Monitor Ctrl+ Shift+M

403 Serial Plotter Ctrl+Shift+L

;. void loop( WiFi101 / WiFiNINA Firmware Updater

7| // put ¥

B Board: "Arduino Uno" >

I Serial
Get Board Info

Note: If you cannot detect the hardware, please check that you have installed the USB driver
if you are using Arduino Uno SMD or Saleng Uno. You may also want to check other USB ports
incases when a port may be damaged. Finally, you could confirm if your hardware is
detectable using another computer.

4. Go to tools>board>Arduino AVR boards and select Arduino Uno

File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_mar1¢ Fix Encoding & Reload
1|void setup Manage Librariss... Ctrl+5Shitt+I
7 /PR Serial Monitor Ctrl+Shift+M
4|3 Serial PlolLer Cul+shilt+L
E, void loop( WIFi101 / WiFININA Firmware Updaler &
i A ak Arduino Yin
] Buard: "Arduino Ung" . Boards Marnager...
2t Mort Arcuino ARM (32-bits) Boards Arduine Duemilanove or Dierimila
Get Board Info Arduino AVR Boards AilGino Nane
Programmer: "USBasp" ATtiny Modern Arduino Mega ar Mega 2560
AT - . - e

5. Now we are set to write our first code. In this exercise, copy the program below into the
Arduino IDE editor.
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File Edit Sketch Tools Help

Activity_1_First_Upload §

1 void setup() {
// put your setup code here, to run once:
pinMode (13, OUTPUT) ;

}

void loop() {
// put your main code here, to run repeatedly:
digitalWrite (13, HIGH);
delay(500);
digitalWrite (13, LOW) ;
delay (1000},
}

[ N O o w RS [T TN O Y SO WP T %

d et el

[
b

Notice that the picture shows the line numbers of the code. This is a good reference when
discussing the code. To activate this feature, go to File>Preferences and this tick on the “Display line
number” gption. You may want to enable verbose output during compilation and upload. Follow the
red boxes below:

|Preterences x|
| Settings Network

Skatchbouk lucalivn:

Lexdl oy

— \Arduing Skelchbock Bruwse
| ditor language: |5ysmm efault '«| (requires restart of Arduinn
Editor fant size: 11 |
Interface scale: B3 nutomatic | 1005 3% (requires restart of Ardulno)
Theme: Cefoult theme | (requires restart of Arduino)
Show verbose output during: [B compllation [ upload I
Cornipiler warnings; Nope

I n Display line numbers [ JEnable Code Folding
[ ] Verity coce after uplozd [ ] Use externzl editor
B3 Check for updates on startup B save when verifving or uploading
[ JUse actessitilily Tealures
Additional Doards Manager URLs: .l:om,:’chiplC[T32,:’chiplﬂT-core{ra\w’masteq‘pal:kage_chipkit_indEx_jscn| g
Mrore preferences can he edited diredtly in the file
C:\Users\cdmal\AppData\Local \Arcuinol Spreterances bt
(edil only when Arduing is nol running)
0K Cancel
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EE EEEE EEE EEEE N N N I N .
REVIEW: Comments inC/C++ may be added using // followed whatever text to the right. It may also be
done by enclosing the text in /* and */. Comments do not have an effect on the instructions to be uploaded
into the microcontroller. These are used as helpful text for the reader of the code and may be used for
purposes like improving readability, providing notes about the algorithms, and many other purposes. In our
default editor screen, you should notice the two comments already on screen. Deleting these lines will not
affect the code itself.

void setup() {

// put your setup code here, to run once: <== thiS iS5 @ comment
pinMode (13, QUTPUT) ;

} I
// put your main code here, to run repeatedly: <-- this is a comment

digitalWrite {(13,HIGH) ;

delay (500} ;

digitalWrite (13, LOW);
delay (1000) ;

1
2
3
4
& |void loop{) {
7
]
9

[

i
;

= [
[0 T N W T O

}

(Y

1

r—-—-

6. Upload the code by clicking on the right arrow icon or going to Sketch>Upload

Activity_1_First_Upload | Arduino 1.8.16
File Edit Sketch Tools Help

ity _1_First_Upload

etup(} {
put your setup code here, to run on
ode {13, OUTPUT) ;

A

}

UPLOAD BUTTON

void loop() {
// put your main code here, to run rept
digitalWrite (13,HIGH) ;
delay (500} ;

LW T o o TS s TN ¥ Y SR W T - B

7. Wait for the upload to complete. You should see some messages at the console area during
uploading
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8. After a successful upload, you will see a screen similar to below

& Activity_1_First_Upload | Arduino 1.8.16
File Edit Sketch Tools Help

Activity_1_First_Upload

1 woid setup(} {
Z // put your setup cods here, to run crce:
3 pinMode (13, QUTDUT] ;

void loop(} {
/4 put your main code here, to run repeatedly:
g digitalWrite (13, HIGH) ;
delay (500) 7
digitalWrite (13, T.0W) ;
i1 delay (1000} ;
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9. Congratulations! You have just uploaded your first code. Now check the “L” LED on the
Arduino/Saleng Uno. It will turn on for 0.5 [S00 milliseconds) second and turn off for 1 second
(1000 milliseconds).

BASIC CODE STRUCTURE

Writing the code follow basic rules and structure that must be followed. When a new editor window is
opened, the basic elements are automatically created as in below. Here are the basic guidelines:

roid semun () {
/¢ pul your selup code hers, Lo rcun opce: Se‘tup” |5 executed one t|me r|ght
b after power up
roid leop () { 2 .
/¢ put vour main cods hers, to run repsatedly: IODpO 15 E}(ECUtEd rlght after
b setup(). It is executed repeated.

e The code is written and read from top to bottom, left to right.

e On power up, whatever is written inside the setup() function is executed first.

e After this , the contents of the loop|) function is executed repeatedly from top to bottom and
then repeating at the top.

e All other functions will be written by the author and shall be called from setupl) or loopl)

Looking back at activity I, we could dissect the code as follows:

1iveid sctup{} |

2 // put yoar sctup code here, tc run once:
3 pirMcde (13, 0UTEUT) ; set pin 13 as an
Bl output pin
6lvuid luop() A
Jf put yoir rain rode nere, to thnrn repeatedly: " k 2 " d
8| aigicaimslEais, aaci output a HIGH logic [SV] at pin 13. This will turn on the
Y dalay(5UU); internal "L" LED connected ta pin 13
dicitalWrite {13, LOW ) 5 —
11] delay (100D} ; wait for 500 milliseconds
129}
:Z output a LOW logic [OV] at pin 13. This will tun
15 off the internal "L" LED connected to pin 13

wait for 1000 milliseconds
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The Arduino environment implements an abstraction layer that simplifies a lot of complexities
related to microcontrollers. It also implements hardware specific functions. As such, the “Arduino”
programming language is not 100% standard ANSI C or standard C++. As stated, this document
does not cover the whole subject of programing and programming language. Instead, the reader
may find time to research on the basic Arduino related functions:

e pinMode(pin,direction) — pinMode() sets an I/0 pin as either an output or an input.
e digitalWrite(pin, state) — this sets the pin to a HIGH or LOW logic state
e digitalRead(pin) - returns the logic state of pin

e analogRead(pin) - returns the analog value of the voltage applied to pin as an integer from 0 to
1023 where 0 represents OV and 1023 is 5V. This is applicable for pins AO to A5 only. For extended
reading, search for “Analog to Digital Conversion”

e delay(ms) —tells the processor to wait and do nothing for the time defined by ms in milliseconds.

For extended reading, go through the resources in docs.Arduino.cc/learn/

You may also go through https.//www.arduino.cc/reference/en/ as a quick function reference

_ i Jdocs.arduino.co/learn,

HARDWARE SOFTWARE + CLOUD = PROGRAMMING TUTORIALS LEARN

Learn Arduino Ecosystem Microcontrollers Programming Electronics Communication Hardware Design Built-in Lib

Microcontrollers ® pigital Pins

Discover how digital pins work end how they can be configured.

™ Analog Input Pins

Find out how analog input pins work on an Arduino.
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ACTIVITY 2: SERIAL MONITOR TESTING

The Arduino IDE includes a software tool called “Serial Monitor”. It is used to talk to any COM port as
emulated in the computer by your Arduino/Saleng Uno hardware. This gives the user the ability to
communicate to the Arduino from the computer using simple text [ASCII) characters.

The Serial Monitor can be launched from tools>Serial Monitor in the Arduino IDE or with the keyboard
shortcut Ctri+Shift+\.

Activity 2 Serial Monitor_Test | Arduino 1.8.16
File Edit Sketchf Tools|Help

Auto Format Ctrl+T
Archive Sketch
Activity_2_Se Fix Encoding & Reload
1/* Manage Libraries... Ctrl+Shift+l
A ool vonior . [E=y
2 -’“—t-*-;fi'*‘T Serial Plotter Ctrl+ShifteL  175C
* Authoxn

A new window launches as shown below:

COM port number of the current selected
part under Tools=Port

@ comn = D %
| . — transmits out the
|l data to transmit | sen— data to the Arduino

received data goes here

LB Aot [ St ot gecie T R e S fﬁiﬁﬁiata
I adjus'ls the
If selected, time is baud rate

displayed on the left
side of the received
data

Monitor to append or not to append New
Line and Carriage Return characters as
the send button is pressed
Automatically scrolls the received

data as New Line or Carriage

Return is received
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As an exercise, upload the code below :

void setup() |
Serial.begin(9600);

Serial.println("Loop Back Test: Send any character from Serial Monitor and see it reflected back."):

¥

void loop() |
if (Serial.available())

{

Serial.write (Serial.read());
}
i}

Follow the steps in uploading:

I IS I I S S S -
I REVIEW: steps in uploading sketches/code: I

Connect cable into Arduino and Computer
Tools>Board>Arduino AVR Boards>Arduino Uno I
Tools>Port>COM port of your Arduino

Click on Upload Button

Wait until “Upload Done” id shown I

nnshwh =

After uploading, set the baud rate of the Serial Monitor to 9600. Note that every time baud rate is
changed in the Serial Monitor, the Arduino resets the code from start.

@ come - O x
|
|

| Smr:_

Loop Back Tesl: Sond any characler Lrom Scrlal Monlloer and sce DL rellcocled back.

BB Autoserall — Shews timestarp Anth NI & CR i

Any data you send shall be echoed back into the received data display. This simple exercise
demonstrates how the Serial Monitor may be used to communicate with the Arduino.
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CAR ASSEMBLY

Follow these steps to assemble everything:

l. Peel off the protective film on both sides of the Arcylic base board and motor clips. This is an
optional step as some users may want to keep the protective film on. However, this will
weaken the use of double sided tape as the film may give way in time.

2. In some kit versions, you will need to solder the wires into the motor terminals. If you need a
kit with the wires soldered, contact Layad Circuits to customize the kit. Since the motors do
not have a polarity, you may use any wire on the terminals. However, for consistency, this
document will use the same color orientation below.
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3. Attach the motors and third wheel into the base board. You may refer to the assembly video
from our YT channel found in this link: www.youtube.com/watch?v=L8PzoMVqsNE

Use the brass hex standoffs to support the third wheel. Use the 4 acrylic clips to support the
motors. The long screws are used to attach the motors into the acrylic clips. If you are looking
for a kit that already implements this step, contact Layad Circuits for kit customization.

4. Apply double sided tape into the following components
o Battery Holder
e Arduino/Saleng Uno
e Motor Driver
e DC Jack adapter

5. Install the above components into the
base board. Remove sticker backing
as you install each component.
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While there is no correct location of installation for
the components, it is noteworthy to consider the
notes below. You may also copy how the installation
was done in this document by following the images in mm
this section. - |
e Provide access to the Arduino Uno USB port
for easy access when programming
¢ Provide access to the DC jack adapter
e The battery plug must have sufficient wire
length to reach the DC jack as this is the
method used in this kit to turn the robot car on BOTTOM
and off.
e The wires from the motors should have
sufficient length to reach the terminal blocks.

s Il

cult

e The distance between the DC
jack adapter and motor driver
should be close enough for the
power wire.

¢ In our suggested assembly,
we have installed the battery
holder at the bottom of the
base board together with the
motors and third wheel. The
rest are installed on top.
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6. Install the ultrasonic
sensor module into
the base board, to do
this, use double sided
tape underneath the
sensing elements
[eylindrical
components) and
support this with a
cable tie around the
module and into the
holes of the base
board. Keep the
sensor terminals on
top for easy access
of the connecting
wires. Cut off the
excess cable tie.

7. Attach the main wheels into the left and right motors
e Align the wheel coupling into the motor shaft

e Push the wheel into the shaft. For double shaft
motors, support the opposite side of the shaft.
Avoid excessive force to prevent damaging the
shaft.
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At this point, the assembly should be similar to the image below:

8. Insert the motor wires into available holes on the base board from the bottom side to the top
side towards the terminals of the Motor Driver board. For consistency, this document will
follow the table below

Motor Driver Terminals  Wire Color, Motor side
OuTI RED, RIGHT MOTOR
ouT2 BLACK, RIGHT MOTOR
OuT3 RED, LEFT MOTOR
ouT4 BLACK, LEFT MOTOR
Use a 3mm or similarly sized flat head or Philips screw driver to connect wires into the
terminal blocks
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Connect the power wire and a red-brown pair from the connectors in parallel to the DC jack
adapter. Strip the female header portion of the 2 connectors and strip off around 5-10mm of
the insulator. This will serve as the connector for the power of the Arduino via the VIN (and
GND) pin.

——\

—-/

The stripped end of this 2 wires will be connected in parallel with the power cable or the DC
jack connector. Follow the color conventions where the red wires connect to the positive
terminal and the black/brown wires connect to the negative terminal.

The other end of the power wire goes to the 12V [+, red) and GND (-, black) terminals of the
motor driver. On the other hand, the connecting wires coming from the positive side [red wire)
goes into the VIN header of the Arduino. The brown connector goes to any GND pin within the
Arduino. Follow the wiring diagram in the succeeding page/s.

Connect the 2 set of wires into the DC jack adapter using the screw terminals. A 3mm flathead
or Philips screw driver is required for this.
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9. Remove or place the microjumpers of the motor driver into one pin. We will need the ENA and
ENB pins.
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10. Connect the other connectors:
e Motor driver INI-IN4 and ENA and ENB to Arduino
e Ultrasonic headers to Arduino
Follow the wiring diagram in the succeeding page/s.

WIRING DIAGRAM

A wiring diagram is provided here as a reference for the electrical connections. The lines in the
diagram represent physical wires. Lines that intersect in the diagram does not mean physical or
electrical connection unless it is mentioned with text of indicated by a dot. A soft copy can be

downloaded from our website at layadcircuits.com/ds/2WD_basic_kit_KIT0OO08/
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Plug in DC jack to turn

robot car ON. Unplug to

turn OFF. L WOH-ITAL'E
Uvwoozz 0981 044

NOTE: WIRES THAT
LAYADCIRCUITS wrersect are not
ELECTRICALLY CONNECTED

Arduino DC input Jack UNLESS INDICATED.
will not be used

connect 2 wires
into each screw
terminal

e & 888 8088

* 0NN 9NIIYS
. SLNJHIDAaYAY
20 [ECLCTLE

WA v s T |pr| ¥i

0000

. # ans AZT+ TLNOD
. TLNO

www layadcircuits.com Copyright 2022 © Layad Circuits All Rights Reserved revl.0.0 22/02/28 28
Layad Circuits Electronics Engineering Supplies & Services, B314 Lopez Bldg., Session Rd. cor. Assumption Rd., Baguio City, Philippines
General inquiries: info@layadcircuits.com Sales: sales@layadcircuits.com FB: faceboolc.com/layadcircuits Mobile: +639164428565




@@w@@@u&a@wﬁ@ USER GUIDE

IANALGOEEIDIGITABEIENGINEERING] KITOO8: Basic 2WD Robot Kit

ACTIVITY 3: DISTANCE SENSING

Arduino Pins Ultrasonic Sensor Pins
GND GND
AO TRIG
Al ECHO
Note that although we are using the “Analog” pins AD and Al, we shall use them as digital 170 in this

exercise.

For this exercise, we do not need to connect the battery as we will not use the motors. The USB will
provide sufficient power for the Arduino and ultrasonic sensor.

Upload the following code into the Arduino:

const byte PIN ULTRASCONIC TRIG = AO;
const byte PIN ULTRASCONIC ECHO = Al;
const byte PIN LED BUILTIN = 13;
unsigned long Eime:of_flight;
unsigned int distance;

void setup() |
pinllode (PIN_ULTRASONIC_TRIG, OUTEUT) ;
pinllode (PIN_ULTRASONIC_ECHO , INPUT) ;
pintode (PIN LED BUILTIN, CUTEUT);,
Serial.begin(9600);

}

void loop() {
// Generate trigger pulse
digitalWrite( PIN ULTRASCNIC TRIG, LOW) »
delayMicroseconds (2);
digitalWrite (PIN ULTRASCNIC TRIG, HIGH):;
delayMicrosecondE(lO); o
digitalWrite( PIN ULTRASCNIC TRIG, LOW) ;

// Measure the time of flight of the ultrasonic waves
// We shall limit the distance to 1 meter and therefore the time to 30ms max.
time of flight = pulseIn(PIN ULTRASCNIC ECHO, HIGH, 30000);

// Compute distance from time of flight

// Note that the time of flight is round trip time

// so we divide this by 2. We assume the speed of sound

// is 346 m/sec (at 25C in air). The unit of time of flight
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// i3 in microseconds while our target output unit is centimeters.
// Therefore we shall have:
distance = time of flight*0.0346/2;

// limit the valid distance between Z2cm and our limit of 100cm
if(distance <2 || distance >100) distance = 100;

// send this distance to the Serial Monitor
Serial.print (distance);
Serial.println("™ cm");// include the unit and a new line (println())

// turn on the builtin LED when we detect less than 30cm and
// turn if off when we are over 30cm

if(distance > 30) digitalWrite(PIN LED BUILTIN, LOW) ,

else digitalWrite (PIN LED BUILTIN,HIGH);

delay (100); // prevent very fast printing

To see the distance, open the Serial Monitor and set to 9600 baud rate. The sensed distance should
be displayed on screen. A few things to note:

e We have set the max distance to 100cm as this is the practical distance that our robot will be
working on. Whenever a distance is sensed to be longer than this, the display is set to 100cm

e When an object is too close, or when there are issues with the reflected ultrasonic wave, or if
there is no return wave in the case of very far obstacles, then we sill still get 100cm. We
forced this behavior in the code to prevent issues in other activities in this document.
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[===n N N N e N N N I L
REVIEW: Ultrasonic Ranging uses the time of flight of ultrasonic waves and uses this to
compute approximate distance of the obstacle assuming the speed of sound in air. However, I
I we should consider possible factors that will affect the accuracy of the readings:

obstacle to the sensor elements

v B—=
X | >

I e Ultrasonic waves may be deflected by angled obstacle. Ideally, we want a perpendicular I

I I I I S S S S S S e .
e Certain materials may absorb or scatter ultrasonic waves, hence, the return signal may
I be too weak to detect
¢ DObstacles too close, at about 5cm or closer, may not be reliably detected by the
sensor. On paper, a 2cm minimum distance is specified for the sensor. In practice that

I may be around S5cm. Limiting readings to a certain minimum is a good way to handle
these errors.
e Other ultrasonic sources such as another sensor that is emitting ultrasonic waves within
I the field of view of a sensor may interfere with the readings

¢ Although with minimal effect, ambient environment also affects the speed of the
waves. These include temperature and humidity.

I All of these affect sensor readings, consider them whenever writing your code.
I N N EE N N N N N N
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ACTIVITY 4: DIRECTION CONTROL

In this activity, we shall demonstrate how to control the direction of the motors. Because the activity
requires the motors, the battery will be connected to test the result. However, during upload, we
must keep the batter disconnected. We only connect if after the upload is completed and the USB
cable is removed.

Because the motors require a Iot more power that what one Arduino I0 pin can offer [40mA at 5V),
we will need the motor driver module to perform the heavy lifting but still controlled by the Arduino.

The following are the control pins of the L298N/L293D:

Motor Driver Function Affected Motor
Pin Name

ENA Enable/Disable pin = may be used for speed control of Right Motor
OUTI/0UT2

IN1 Qutput control pin for QUTI Right Motor

IN2 Output control pin for QUT2 Right Motor

IN3 Qutput control pin for OUT3 Left Motor

IN4 Output control pin for OUT4 Left Motor

ENB Enable/Disable pin — may be used for speed control of Left Motor
0OUT3/0UT4

To control direction of a motor, the Arduino must drive the input pins following the table below

RESULTING DIRECTION OF RIGHT moTOR

FORWARD
BACKWARD

RESULTING DIRECTION OF LEFT MOTOR
FORWARD
BACKWARD
The tables above are for the motors individually. We could combine them into a single table to show
the logic we need to make the robot move forward, backward, left and right.
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RESULTING DIRECTION OF

wHoLe ROBOT CAR
FORWARD
BACKWARD
TURNS LEFT
TURNS RIGHT
LOW LOW LOW LOW CAR STOPS
HIGH HIGH HIGH HIGH CAR STOPS

In this exercise we shall use the assembled robot car. Put an object/s underneath the car excluding
the wheels. This will keep the robot from moving while we check the direction of the motors.

Disconnect the DC plug from the battery when uploading codel

Although the Arduino/Saleng Uno will have a circuit to allow both
its DC jack and USB to be powered at the same time, the risk of
the battery voltage entering the lower voltage of the USB bus is
eliminated by using either the battery alone or the USB alone.
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Through this document, we shall reference the front, left and right sides of the car following the
topview diagram below:

The arc of the acrylic base board is the front side. This is the FORWARD direction. Left and right
sides are referenced with respect to the robot car.

Upload the following code:

const byte PIN MOTORDRIVER ENA = 5
const byte PIN MOTORDRIVER IN1 = 6
const byte PIN MOTORDRIVER IN2 = 7
const byte PIN MOTORDRIVER IN3 = 8
const byte PIN MOTORDRIVER IN4 = 9;

const byte PIN MOTORDRIVER ENB = 10;
const byte PIN ULTRASONIC TRIG = AO;
const byte PIN ULTRASONIC ECHO = Al;
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const byte PIN LED BUILTIN = 13;

void robot stop()
{

digitalWrite (PIN MOTORDRIVER IN1, LOW);
digitalWrite (PIN MOTORDRIVER INZ2, LOW);
)
)

r

digitalWrite (PIN MOTORDRIVER IN3, LOW
digitalWrite (PIN MOTORDRIVER IN4, LOW

r

}

void robot forward()

{
digitalWrite(PIN_MOTORDRIVER_INl,LOW);
digitalWrite(PIN_MOTORDRIVER_IN2,HIGH);
digitalWrite(PIN_MOTORDRIVER_INB,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN4,LOW);

void robot backward()

{
digitalWrite(PIN_MOTORDRIVER_INl,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN2,LOW);
digitalWrite(PIN_MOTORDRIVER_INB,LOW);
digitalWrite(PIN_MOTORDRIVER_IN4,HIGH);

}

void robot right()

{
digitalWrite(PIN_MOTORDRIVER_INl,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN2,LOW);
digitalWrite(PIN_MOTORDRIVER_INB,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN4,LOW);

}

void robot left ()

{
digitalWrite(PIN_MOTORDRIVER_INl,LOW);
digitalWrite(PIN_MOTORDRIVER_IN2,HIGH};
digitalWrite(PIN_MOTORDRIVER_IN3,LOW};
digitalWrite(PIN_MOTORDRIVER_IN4,HIGH);

void set speed leftmotor (byte wval)

{
analogWrite (PIN MOTORDRIVER ENB,val);
}

void set speed rightmotor (byte val)
{
analogWrite (PIN MOTORDRIVER ENA,val);

}
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void set speed robot (byte val)
{
set speed leftmotor (val);
set speed rightmotor (val);

}

void setup() |
pinMode (PIN MOTORDRIVER ENA, OUTPUT);
pinMode (PIN MOTORDRIVER IN1, OUTPUT);
pinMode (PIN MOTORDRIVER IN2, OUTPUT);
pinMode (PIN MOTORDRIVER IN3, OUTPUT);
pinMode (PIN MOTORDRIVER IN4, OUTPUT);
pinMode (PIN MOTORDRIVER ENB, OUTPUT);

set speed robot (64); // keep the speed low to be able to cbserve the direction

delay (3000),; // add start up delay
}

volid loop() {
robot forward();
delay (2000} ;
robot stopl();,
delay (1000) ¢
robot backward();
delay (2000) ¢
robot stop();
delay (1000} ;

}

Power Up the robot by inserting the DC plug from the battery into the DC jack adapter.

Notice how we encoded our truth table in the code as functions named:

° robot_s top ()

° robot_forward ()

° robot_backward ()
° robot_right ()

° robot_left ()
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In the loop(), we alternately turn the right motor forward and backward. Edit the code if you want to
try this on the left motor.

The controlling the motors in one direction and shifting to the
opposite direction immediately induces high currents that will stall
the motor driver. Excessive currents could potentially damage the
motors or the electronics. To avoid this, we first need to stop the
motor, wait for a short time and then move to the opposite
direction. This preventive method is shown in this exercise

ACTIVITY 5: SPEED CONTROL

As already stated in the previous exercise, we could control the speed of the robot car by applying
PWM signals at the ENx pin of the motor controller.

N N N N EEE N T N I e
REVIEW: Pulse Width Modulation [PWM) is one technique readiliy available in the Arduino to
control power applied to a certain load , motors in this case.

The Arduino has built in PWM peripherals hardwired into 6 pins: pins 3,5,6,9,10 and Il. These I
pins can generate an 8-bit PWM signal using the analogWrite () function.

I analogWrite () accepts 2 parameters, the first if the pin number and the second is a
value between O to 255 where 255 is the fastest speed (I00% duty cycle) and O will
render the motors to stop (0% duty cycle). Example, if we want to set pin 3 to 50%
duty cycle, we can call this: analogWrite (3,128) ; I

Upload the following code into the Arduino. Be sure the disconnect the battery before uploading.
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const byte PIN MOTORDRIVER ENA =
const byte PIN MOTORDRIVER IN1
const byte PIN MOTORDRIVER IN2
const byte PIN MOTORDRIVER IN3
const byte PIN MOTORDRIVER IN4
const byte PIN MOTORDRIVER ENB
const byte PIN ULTRASONIC TRIG = AO;
const byte PIN ULTRASONIC ECHO = Al;
const byte PIN LED BUILTIN = 13;

void robot stop()
{
digitalWrite(PIN_MOTORDRIVER_INl,LOW);
digitalWrite(PIN_MOTORDRIVER_IN2,LOW);
)
)

r

digitalWrite (PIN MOTORDRIVER IN3, LOW
digitalWrite (PIN MOTORDRIVER IN4, LOW

r

}

void robot forward()

{
digitalWrite(PIN_MOTORDRIVER_INl,LOW);
digitalWrite(PIN_MOTORDRIVER_IN2,HIGH);
digitalWrite(PIN_MOTORDRIVER_INB,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN4,LOW);

void robot backward()

{
digitalWrite(PIN_MOTORDRIVER_INl,HIGH};
digitalWrite(PIN_MOTORDRIVER_IN2,LOW};
digitalWrite(PIN_MOTORDRIVER_IN3,LOW};
digitalWrite(PIN_MOTORDRIVER_IN4,HIGH};

}

void robot right()

{
digitalWrite(PIN_MOTORDRIVER_INl,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN2,LOW);
digitalWrite(PIN_MOTORDRIVER_IN3,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN4,LOW);

}

void robot left ()
{
digitalWrite(PIN_MOTORDRIVER_INl,LOW);
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digitalWrite (PIN MOTORDRIVER INZ,HIGH);

digitalWrite (PIN MOTORDRIVER IN3, LOW);

digitalWrite (PIN MOTORDRIVER IN4,HIGH)
}

void set speed leftmotor(byte wval)
{

analogWrite (PIN MOTORDRIVER ENB,val);
}

void set speed rightmotor (byte val)
{

analogWrite (PIN MOTORDRIVER ENA,val);
}

void set speed robot(byte val)
{
set speed leftmotor (val);
set speed rightmotor (val);

}

void setup() {
pinlMode (PIN MOTORDRIVER ENA, OUTPUT);
pinMode (PIN MOTORDRIVER IN1, OUTPUT)
pinlode (PIN MOTORDRIVER IN2, OUTPUT);
pinMode (PIN MOTORDRIVER IN3, OUTPUT);
pinMode (PIN MOTORDRIVER IN4, OUTPUT);
pinMode (PIN MOTORDRIVER ENB, OUTPUT);

r

delay (3000),; // add start up delay
robot forward(); // keep the motors running forward

set speed robot (90); // initialize speed a low value

}

volid loop() {
set speed robot (50);
delay (1000) ;
set speed robot (120);
delay (1000) ;
set speed robot (150);
delay (1000) ;
set speed robot (180);
delay (1000) ;
set speed robot (210);
delay (1000) ;
set speed robot (255); //max speed
delay (1000) ;
set speed robot (0); // motors are disabled and will stop
delay (2000} ;
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Power Up the robot by inserting the DC plug from the battery into the DC jack adapter.

See how the speed of the wheels gradually increases and how easy this can be done with
set_speed_robot O .

Play around with the value inputin set speed robot() and observe how it affects the speed of
the motor.

The PWM value of 0-255 is a scaled representation of the duty
cycle. Note however that below a certain PWM value, the power
applied to the motors may not be sufficient to even rotate the
motors. This can vary between motors and battery charge
conditions.

ACTIVITY 6: HAND FOLLOWER

In the output of this activity, the car is

expected to move forward or to “follow” | 20-50cm |
the palm of the user [or any obstacle) - ' '
when it is presented between 20 and

50cm from the sensor. Outside of this a0 [:>

range, the robot will stop. Only the loop()
function is modified from the previous
activity.

() moves forward

car moves forward when obstacle is detected
at 20-50cm. Otherwise it stops

| 20-50cm |
I 1

[ —
stapped
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Upload the following code. Keep the battery disconnected while doing the upload. Reconnect the
battery plug once upload is complete to start the car.

const byte PIN MOTORDRIVER ENA = 5
const byte PIN MOTORDRIVER IN1 = 6
const byte PIN MOTORDRIVER IN2 = 7
const byte PIN MOTORDRIVER IN3 = 8;
const byte PIN MOTORDRIVER IN4 = 9
const byte PIN MOTORDRIVER ENB = 1
const byte PIN ULTRASONIC TRIG = AO;
const byte PIN ULTRASONIC ECHO = Al;
const byte PIN LED BUILTIN = 13;

void robot stop()

{
digitalWrite(PIN_MOTORDRIVER_INl, LOW) ;
digitalWrite(PIN_MOTORDRIVER_IN2, LOW) ;
digitalWrite(PIN_MOTORDRIVER_INB, LOW) ;
digitalWrite(PIN_MOTORDRIVER_IN4, LOW) ;

}

void robot forward()

{
digitalWrite(PIN_MOTORDRIVER_INl, LOW) ;
digitalWrite(PIN_MOTORDRIVER_INE, HIGH) ;
digitalWrite(PIN_MOTORDRIVER_INS, HIGH) ;
digitalWrite[PIN_MOTORDRIVER_IN4, LOW) ;

}

void robot backward()

{
digitalWrite(PIN_MOTORDRIVER_INl, HIGH) ;
digitalWrite(PIN_MOTORDRIVER_IN2, LOW) ;
digitalWrite(PIN_MOTORDRIVER_INB, LOW) ;
digitalWrite(PIN_MOTORDRIVER_IN4, HIGH) ;

}

void robot right()

{
digitalWrite(PIN_MOTORDRIVER_INl, HIGH) ;
digitalWrite(PIN_MOTORDRIVER_IN2, LOW) ;
digitalWrite(PIN_MOTORDRIVER_INB, HIGH) ;
digitalWrite(PIN_MOTORDRIVER_IN4, LOW) ;
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}

void robot left ()

{
digitalWrite(PIN_MOTORDRIVER_INl, LOW) ;
digitalWrite(PIN_MOTORDRIVER_IN2, HIGH) ;
digitalWrite(PIN_MOTORDRIVER_IN3, LOW) ;
digitalWrite(PIN_MOTORDRIVER_IN4, HIGH) ;

}

void set speed leftmotor(byte wval)
{

analogWrite (PIN MOTORDRIVER ENB, wval);
}

void set speed rightmotor (byte val)
{

analogWrite (PIN MOTORDRIVER ENA, wval);
}

void set speed robot(byte val)
{
set speed leftmotor (val);
set speed rightmotor(val);

}

vold setup() |
pinlMode (PIN MOTORDRIVER ENA, OUTPUT);
pinMode (PIN MOTORDRIVER IN1, OUTPUT)
pinMode (PIN MOTORDRIVER IN2, OUTPUT);
pinMode (PIN MOTORDRIVER IN3, OUTPUT);
pinMode (PIN MOTORDRIVER IN4, OUTPUT);
pinMode (PIN MOTORDRIVER ENB, OUTPUT);
pinMode (PIN ULTRASONIC TRIG, OUTPUT);
pinMode (PIN ULTRASONIC ECHO, INPUT);

r

delay (3000),; // add start up delay

set speed robot (90); // initialize speed at a low value

}

void loop() {
unsigned long time of flight;,
int distance; T
// Read the distance
digitalWrite(PIN_ULTRASONIC_TRIG, LOW) ;
delayMicroseconds (2);
digitalWrite (PIN ULTRASCNIC TRIG, HIGH);
delayMicrosecondg(lO); -
digitalWrite(PIN_ULTRASONIC_TRIG, LOW) ;
time of flight = pulseIn(PIN ULTRASONIC ECHO, HIGH, 30000);
distance = time of flight * 0.0346 / 2;
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if (distance < 2 || distance > 100) distance = 100;

// decide what to do. If distance is more than 30, we stop.
//if distance is 30 or kelow, we move forward.

if (distance >= 20 && distance <= 50) robot forward();
else robot stop():;

delay (50} ;

Adjust the distance range (20 and 50) to get the desired results. Keeping a low speed will also help.

ACTIVITY 7: MODIFIED HAND FOLLOWER

This activity is very similar to the previous one where the car follows the palm of the hand. We will
modify the code so that the palm can be placed anywhere around the car along the floor plane.
Instead of just stopping, we could rotate the car to the right until it “sees” an obstacle to follow.
Removing this obstacle within the allowable distance range will bring the robot to its rotation state.

P 4

car will move to this direction once
ﬁ the hand is detected as it rotates

[
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Upload the following code. Keep the battery disconnected while doing the upload. Reconnect the
battery plug once upload is complete to start the car.

const byte PIN MOTORDRIVER ENA = 5
const byte PIN MOTORDRIVER IN1 = 6
const byte PIN MOTORDRIVER IN2 = 7
const byte PIN MOTORDRIVER IN3 = 8;
const byte PIN MOTORDRIVER IN4 = 9
const byte PIN MOTORDRIVER ENB = 1
const byte PIN ULTRASONIC TRIG = AO;
const byte PIN ULTRASONIC ECHO = Al;
const byte PIN LED BUILTIN = 13;

vold robot stop()
{

digitalWrite (PIN MOTORDRIVER IN1, LOW);
digitalWrite (PIN MOTORDRIVER IN2, LOW);
digitalWrite (PIN MOTORDRIVER IN3, LOW)

digitalWrite (PIN MOTORDRIVER IN4, LOW);

r

}

void robot forward()

{
digitalWrite(PIN_MOTORDRIVER_INl,LOW};
digitalWrite(PIN_MOTORDRIVER_IN2,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN3,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN4,LOW};

vold robot backward()

{
digitalWrite(PIN_MOTORDRIVER_INl,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN2,LOW);
digitalWrite(PIN_MOTORDRIVER_INB,LOW);
digitalWrite(PIN_MOTORDRIVER_IN4,HIGH);

}

void robot right()
{
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digitalWrite (PIN MOTORDRIVER IN1,HIGH);
digitalWrite (PIN MOTORDRIVER IN2,LOW);
digitalWrite (PIN MOTORDRIVER IN3,HIGH);
digitalWrite (PIN MOTORDRIVER IN4,LOW);

void robot left ()

1
digitalWrite(PIN_MOTORDRIVER_INl,LOW);
digitalWrite(PIN_MOTORDRIVER_IN2,HIGH);
digitalWrite(PIN_MOTORDRIVER_IN3,LOW);
digitalWrite(PIN_MOTORDRIVER_IN4,HIGH);

}

void set speed leftmotor(byte wval)
{

analogWrite (PIN MOTORDRIVER ENB,val);
}

void set speed rightmotor (byte val)
{

analogWrite (PIN MOTORDRIVER ENA,val);
}

void set speed robot(byte val)
{
set speed leftmotor (val);
set speed rightmotor(val);

}

void setup() {
pinMode (PIN MOTORDRIVER ENA, OUTPUT);
pinMode (PIN MOTORDRIVER IN1, OUTPUT);
pinMode (PIN MOTORDRIVER IN2, OUTPUT);
pinMode (PIN MOTORDRIVER IN3, OUTPUT);
pinMode (PIN MOTORDRIVER IN4, OUTPUT);
pinMode (PIN MOTORDRIVER ENB, OUTPUT);
pinMode (PIN ULTRASONIC TRIG, OUTPUT);
pinMode (PIN ULTRASONIC ECHO, INPUT);

delay (3000),; // add start up delay

set speed robot (90); // initialize speed at a low value

}

void loop() {
unsigned long time of flight;
int distance;
// Read the distance
digitalWrite(PIN_ULTRASONIC_TRIG, LOW) ;
delayMicroseconds (2);
digitalWrite(PIN_ULTRASONIC_TRIG, EIEEE.

www layadcircuits.com Copyright 2022 © Layad Circuits All Rights Reserved revl.0.0 22/02/28 45
Layad Circuits Electronics Engineering Supplies & Services, B314 Lopez Bldg., Session Rd. cor. Assumption Rd., Baguio City, Philippines
General inquiries: info@layadcircuits.com Sales: sales@layadcircuits.com FB: faceboolc.com/layadcircuits Mobile: +639164428565




IANALGOEEIDIGITABEIENGINEERING] KITOO8: Basic 2WD Robot Kit

L ATavAREREINS e oLl

delayMicroseconds (10) ;

digitalWrite (PIN ULTRASONIC TRIG, LOW);

time of flight = pulseIn(PIN ULTRASONIC ECHO, HIGH, 30000);
distance = time of flight*0.0346/2;

if(distance <2 || distance >100) distance = 100;

// decide what to do. If distance is more than 30, we stop.
//1if distance is 30 or below, we move forward.

if(distance >= 20 && distance <= 50) robot forward():;
else robot right();

delay (50);

After upload, connect the battery and test by placing your palm [or any obstacle) any where around
the robot car along the floor plane. Expect the robot to follow. Remove your hand to keep the motor
rotating. In this activity, the robot car could follow the hand in any direction.

ACTIVITY 8: OBSTACLE AVOIDANCE

This activity uses the same template as previous program, only the contents of the loop() are
modified. The output shall be a mobile robot car that moves to the left or right whenever an obstacle
is detected. Otherwise, it moves forward.

Upload the following code. Unplug the battery before uploading.

const byte PIN MOTORDRIVER ENA =
const byte PIN MOTORDRIVER IN1
const byte PIN MOTORDRIVER IN2
const byte PIN MOTORDRIVER IN3
const byte PIN MOTORDRIVER IN4
const byte PIN MOTORDRIVER ENB
const byte PIN ULTRASONIC TRIG = AO;
const byte PIN ULTRASCNIC ECHO = Al;
const byte PIN LED BUILTIN = 13;

Il
T te B s S e N &
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void robot stop()

{
digitalWrite(PIN_MOTORDRIVER_INl, LOW)
digitalWrite(PIN_MOTORDRIVER_IN2, LOW) ;
digitalWrite(PIN_MOTORDRIVER_IN3, LOW)
digitalWrite(PIN_MOTORDRIVER_IN4, LOW)

}

void robot forward()

{
digitalWrite(PIN_MOTORDRIVER_INl, L 5
digitalWrite(PIN_MOTORDRIVER_IN2, HIGH) ;
digitalWrite(PIN_MOTORDRIVER_IN3, HIGH)
digitalWrite(PIN_MOTORDRIVER_IN4, LOW) ;

void robot backward()

{
digitalWrite(PIN_MOTORDRIVER_INl, HIGH) ;
digitalWrite(PIN_MOTORDRIVER_IN2, LOW) ;
digitalWrite(PIN_MOTORDRIVER_INB, LOW) ;
digitalWrite(PIN_MOTORDRIVER_IN4, HIGH) ;

}

void robot right()

{
digitalWrite(PIN_MOTORDRIVER_INl, HIGH) ;
digitalWrite(PIN_MOTORDRIVER_INE, LOW) ;
digitalWrite(PIN_MOTORDRIVER_INS, HIGH) ;
digitalWrite[PIN_MOTORDRIVER_IN4, LOW) ;

}

void robot left ()

{
digitalWrite(PIN_MOTORDRIVER_INl, LOW) 2
digitalWrite(PIN_MOTORDRIVER_IN2, HIGH) ;
digitalWrite(PIN_MOTORDRIVER_IN3, LOW)
digitalWrite(PIN_MOTORDRIVER_IN4, HIGH) ;

}

void set speed leftmotor(byte wval)

{
analogWrite (PIN MOTORDRIVER ENB, wval);

}

void set speed rightmotor (byte val)
{

analogWrite (PIN MOTORDRIVER ENA, wval);
}

void set speed robot(byte val)
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set speed leftmotor (val);
set speed rightmotor (val);

}

volid setup() |
pinlode (PIN MOTORDRIVER ENA, OUTPUT);
pinMode (PIN MOTORDRIVER IN1, OUTPUT);
pinlMode (PIN MOTORDRIVER IN2, OUTPUT);
pinMode (PIN MOTORDRIVER IN3, OUTPUT);
pinlMode (PIN MOTORDRIVER IN4, OUTPUT);
pinMode (PIN MOTORDRIVER ENB, OUTPUT);
pinMode (PIN ULTRASONIC TRIG, OUTPUT);
pinMode (PIN ULTRASONIC ECHO, INPUT);

delay (3000),; // add start up delay

set speed robot (140); // initialize speed at a low value

}

volid loop() {
unsigned long time of flight;,
int distance; B
// Read the distance
digitalWrite(PIN ULTRASCONIC TRIG, LOW);
delayMicrosecond§(2}; o
digitalWrite (PIN ULTRASCNIC TRIG, HIGH);
delayMicrosecondg(lO}; N
digitalWrite( PIN ULTRASCNIC TRIG, LOW) ;
time of flight = pulseIn(PIN ULTRASONIC ECHO, HIGH, 30000);
distance = time of flight * 0.0346 / 2;
if (distance < 2 || distance > 100) distance = 100;

// decide what to do. If distance is more than 30, we stop.
//if distance is 30 or kelow, we move forward.

if (distance < 20} {
if (random(0, 2) == 0} {
robot right (),
delay (100);
}
else {
robot left();
delay (100);
}
}
else {
robot forward();

}

delay (50);
}
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SPECIAL NOTES AND INSTRUCTIONS

l. BATTERY CARE AND USAGE

e [f the robot car does not receive power, check that the Lithium lon batteries are in physical
contact with the battery holder terminals. Move the battery along the slot to get a better
contact.

e When ever the motors are moving, the current consumption is higher hence, it could drain
the batteries faster.

e After several charge-discharge cycles, the battery capacity may wear out. In this case,
replace it with an 18650 Lithium lon battery.

e To conserve the charge-discharge cycle, you may use an AC-DC power supply wall adapter
with a voltage output between 7V and 9V and current rating of at least 2A (2000mA) and
an output plug od 5.5x2.Imm. This can be used during programming/debugging when robot
is not moving.

e Each battery shall reach around 4.2V when fully charged. Therefore, expect around 8.4V at
the DC plug of the holder when both batteries are installed.

o [f the batteries are to be stored for a long time, keeping the batteries at a voltage of
around 3.9V helps keep it healthy while in storage. Recharge to this level if voltage drops
over time.

2. MOTOR DIRECTION
e Code provided in this document assumes that the user has followed the same orientation
of the motor terminals.
¢ Incase the terminals are different as that here, you can adjust either in the hardware or
code side:
o Hardware adjustment — swap the wire terminals in OUTI-OUT2 or OUT3-0UT4
o Software adjustment — change the logic state of the INx pins inside the direction
control functions.

3. MOTOR MINIMUM SPEED
e Although you may control the motor speed using PWM, there is a minimum value at which
the motor will reliably operate. Experiment and determine this value in your case as
different motors and drivers may have differences in this value.

4. MOTOR SPEED DIFFERENCE
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e The motors provided in this kit are basic DC motors which may come with speed
differences at lower PWM values. Avoid this situation by using higher PWM values in
speed control code.

¢ You may also tune the PWM value between left and right motor to match the speed. Note
that the difference may change as you adjust the speed.

5. UPLOAD ISSUES
e Common causes of failed uploads are listed here:
Wrong selection in Tools>Board
Wrong selection in Tools>Port
Port is not detected by the computer - install USB driver or use another USB port
CH34I driver has just been installed - reboot your computer
Pins O and | are connected to a circuit = remove the circuit during upload

EEEEEs O O

6. REFERENCES and TROUBLESHOOTING
e The official Arduino website [Arduino.cc) is one of the best references for Arduino. There
are several topics under it that is worth reading.
e For inquiries on this kit, pls contact us by mobile at 09164428565, email at
info@layadcircuits.com, or at our official FB page at facebook.com/layadcircuits
e For troubleshooting, refer to common problems discussed in the website:
https://www.arduino.cc/en/pmwiki.php?n=guide/troubleshooting
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IMPORTANT NOTICE
Layad Circuits Electronics Engineering Supplies & Services (Layad Circuits) reserves the right to make corrections, enhancements, improvements and other
changes to its products, services and documentations, and to discontinue any product or service. Buyers or clients should obtain the latest relevant
information before placing orders and should verify that such information is current and complete. Additional terms may apply to the use or sale of Layad
Circuits products and services.
Reproduction of significant portions of Layad Circuits information in Layad Circuits datasheets or user guides is permissible only if reproduction is without
alteration, displays the Layad Circuits logo and is accompanied by all associated warranties, conditions, limitations, and notices. Layad Circuits is not
responsible or liable for such reproduced documentation. Information of third parties may be subject to additional restrictions. Resale of Layad Circuits
products or services with statements different from or beyond the parameters stated by Layad Circuits for that product or service voids all express and any
implied warranties for the associated Layad Circuits product or service. Layad Circuits is not responsible or liable for any such statements.
Buyers and others who are developing systems that incorporate Layad Circuits products (collectively, “Designers”) understand and agree that Designers remain
responsible for using their independent analysis, evaluation and judgment in designing their applications and that Designers have full and exclusive
responsibility to assure the safety of Designers' applications and compliance of their applications {and of all Layad Circuits products used in or for Designers’
applications) with all applicable regulations, laws and other applicable requirements. Designer represents that, with respect to their applications, Designer has
all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their
consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. Designer agrees that prior to using or distributing
any applications that include Layad Circuits products, Designer will thoroughly test such applications and the functionality of such Layad Circuits products as
used in such applications. Layad Circuits’ provision of technical, application or other design advice, quality characterization, reliability data or other services or
information, including, but not limited to, reference designs and materials relating to evaluation modules, (collectively, “Layad Circuits Resources”) are
intended to assist designers who are developing applications that incorporate Layad Circuits products; by downloading, accessing or using Layad Circuits
Resources in any way, Designer (individually or, if Designer is acting on behalf of a company, Designer's company) agrees to use any particular Layad Circuits
Resource solely for this purpose and subject to the terms of this Notice.
Layad Circuits' provision of Layad Circuits Resources does not expand or otherwise alter Layad Circuits’ applicable published warranties or warranty disclaimers
for Layad Circuits products, and no additional obligations or liabilities arise from Layad Circuits providing such Layad Circuits Resources.
Layad Circuits reserves the right to make corrections, enhancements, improvements and other changes to its Layad Circuits Resources. Layad Circuits has not
conducted any testing other than that specifically described in the published documentation for a particular Layad Circuits Resource.
NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER LAYAD CIRCUITS INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO
ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF LAYAD CIRCUITS OR ANY THIRD PARTY 15 GRANTED HEREIN, including but not limited to any patent
right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which Layad Circuits products or
services are used. Information regarding or referencing third-party products or services does not constitute a license to use such products or services, or a
warranty or endorsement thereof. Use of Layad Circuits Resources may require a license from a third party under the patents or other intellectual property of
the third party, or a license from Layad Circuits under the patents or other intellectual property of Layad Circuits . Layad Circuits RESOURCES ARE PROVIDED
“AS 15" ANDWITH ALL FAULTS. LAYAD
CIRCUITS DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING RESOURCES OR USE THEREOF, INCLUDING BUT NOT
LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILTY, FITNESS FOR A
PARTICULAR
PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS. LAYAD CIRCUITS SHALL NOT BE LUABLE FOR AND SHALL NOT
DEFEND OR
INDEMNIFY DESIGNER AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY
COMBINATION OF
PRODUCTS EVEN IF DESCRIBED IN LAYAD CIRCUITS RESOURCES OR OTHERWISE. IN NO EVENT SHALL LAYAD CIRCUITS BE LIABLE FOR ANY ACTUAL, DIRECT,
SPECIAL,
COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMFPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF LAYAD CIRCUITS
RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER LAYAD CIRCUITS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Unless Layad
Circuits has explicitly designated an individual product as meeting the requirements of a particular industry standard , Layad Circuits is not resporsible for any
failure to meet such industry standard requirements. Where Layad Circuits specifically promotes products as facilitating functional safety or as compliant with
industry functional safety standards, such products are intended to help enable customers to design and create their own applications that meet applicable
functional safety standards and requirements. Using products in an application does not by itself establish any safety features in the application. Designers
must ensure compliance with safety-related requirements and standards applicable to their applications. Designer may NOT use any Layad Circuits products in
life-critical applications. Life-critical medical equipment is medical equipment where failure of such equipment would cause serious bodily injury or death (e.g.,
life support, pacemakers, defibrillators, heart pumps, neurostimulators, and implantables). Designers agree that it has the necessary expertise to select the
product with the appropriate qualification designation for their applications and that proper product selection is at Designers own risk. Designers are solely
responsible for compliance with all legal and regulatory requirements in connection with such selection. Designer will fully indemnify Layad Circuits and its
representatives against any damages, costs, losses, and/or liabilities arising out of Designer's nancompliance with the terms and provisions of this Notice.
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IANALGOEEIDIGITABEIENGINEERING] KITOO8: Basic 2WD Robot Kit
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